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Disclaimer

This software has been approved for release by the U.S. Geological Survey (USGS). Although 
the software has been subjected to rigorous review, the USGS reserves the right to update the 
software as needed pursuant to further analysis and review. No warranty, expressed or implied, 
is made by the USGS or the U.S. Government as to the functionality of the software and related 
material nor shall the fact of release constitute any such warranty. Furthermore, the software is 
released on condition that neither the USGS nor the U.S. Government shall be held liable for any 
damages resulting from its authorized or unauthorized use. The PAT (Purge Analyzer Tool) can be 
downloaded at https://code.usgs.gov/ptharte/pat.

Acknowledgments

This work was done under an interagency agreement (DW-014-9246101) with the U.S. Environ-
mental Protection Agency (EPA) initiative on Characterization of Fractured Rock. The authors 
would like to thank Edward Gilbert of EPA for his oversight on this initiative. During testing 
of the PAT program, several remedial project managers from the EPA helped facilitate data 
exchange of sampling records of wells. These data proved helpful to assess hydraulic responses 
of pumped wells. Richard Hull and Carol Keating of EPA, Region 1, and Richard Mayer of EPA, 
Region 6 all helped with these data requests. Several state project managers also helped with 
data requests including Peter Bailey and David Herzog of the California Department of Toxic 
Substances Control. Michael Kulbersh of the U.S. Army Corp of Engineers, New England, served 
as a technical reviewer and provided important comments on this manual and the PAT program.





v

Contents
Acknowledgments ........................................................................................................................................iii
Introduction.....................................................................................................................................................1
Contents of Program......................................................................................................................................2

Requirements ........................................................................................................................................2
Instructions  ...........................................................................................................................................3

Input Worksheet ...........................................................................................................................3
Output Worksheet ........................................................................................................................5

Operation .........................................................................................................................................................8
Reverse Mode .......................................................................................................................................8

Option 1: Homogeneous (HF = 1) ...............................................................................................8
Option 2: Heterogeneous Conditions (HF > 1) .........................................................................8

Forward Mode .......................................................................................................................................9
Solver  .............................................................................................................................................................9
Assumptions and Limitations .......................................................................................................................9
Applications ..................................................................................................................................................12
Summary........................................................................................................................................................13
References Cited..........................................................................................................................................13
Appendix 1. Solution Examples using Purge Analyzer Tool ..............................................................16
Appendix 2. Incorporation of Stratigraphic Information in Simulation  ..........................................18
Appendix 3. Additional Examples of Input and Output .......................................................................21

Figures

 1. Diagram showing schematic of the allocation of flow in the well while pumping for 
the Purge Analyzer Tool ...............................................................................................................2

 2. Screenshot showing reproduction of user-specified input parameters (cells 
B4:B14) on the “Input” worksheet for the Purge Analyzer Tool ...........................................3

 3. Screenshot showing reproduction of user-specified program variables (cells 
B29:B32) on the “Input” worksheet for the Purge Analyzer Tool .........................................4

 4. Screenshot showing reproduction of output fields (cells B15:B26) from the “Input” 
worksheet for the Purge Analyzer Tool .....................................................................................4

 5. Screenshot showing reproduction of tabular data outputted on the “Output” 
worksheet for the Purge Analyzer Tool .....................................................................................5

 6. Graph showing reproduction of the horizontal radial inflow graph provided on the 
“Output” worksheet of the Purge Analyzer Tool .....................................................................6

 7. Graph showing reproduction of the vertical velocity graph from the “Output” 
worksheet for the Purge Analyzer Tool .....................................................................................6

 8. Graph showing reproduction of the in-well travel time graph from the “Output” 
worksheet for the Purge Analyzer Tool .....................................................................................7

 9. Graph showing reproduction of the aquifer fraction graph from the “Output” 
worksheet for the Purge Analyzer Tool .....................................................................................8

 10. Screenshot showing reproduction of the “K-distribution” worksheet before layer 
entry for the Purge Analyzer Tool.............................................................................................10

 11. Screenshot showing reproduction of the “K-distribution” worksheet after layer 
entry using a rock fracture analogy where the fracture exists at the middle of the 
well opening for the Purge Analyzer Tool ...............................................................................11



vi

Conversion Factors
U.S. customary units to International System of Units

Multiply By To obtain

Length

inch (in) 2.54 centimeter (cm)
inch (in) 25,400 micrometer (µm)
foot (ft) 0.3048 meter (m)
mile (mi) 1.609 kilometer (km)

Volume

ounce, fluid (fl. oz) 29.57 milliliter (mL)
Flow rate

gallon per minute (gal/min) 3.785 liter per minute (L/min)
cubic inch per minute (in3/min) 16.39 milliliter per minute (mL/min)
cubic feet per minute (ft3/min) 28.3168 liter per minute (L/min)

Velocity

feet per minute (ft/min) 0.3048 meter per minute (m/min)
Hydraulic conductivity

feet per day (ft/d) 0.3048 meter per day (m/d)

Glossary and Abbreviations
Awell  area of well

Arad-2ft  area of mixing zone

b  thickness or length of well opening, ft

dt  time interval for solution to compute aquifer fractional capture, min

DTW  depth to water from land surface datum, ft

DTS  depth to top of screen from land surface datum, ft

Dwell  diameter of well, in inches

HF  heterogeneity factor, a multiple between high and low hydraulic conductivity 
  (K) of a modeled layer, dimensionless

Kavg  average hydraulic conductivity across the screen or well opening, ft/d

KHigh  highest hydraulic conductivity per layer of the screen or well opening, ft/d

Klayer  hydraulic conductivity per layer, ft/d

KLow  lowest hydraulic conductivity per layer, ft/d

Kmedium  medium hydraulic conductivity per layer of the screen or well opening as 
  determined from the average of the KHigh and KLow, ft/d

Lcw  Length (height) of casing water under pumping conditions above top of well 
  opening, ft

LT  cell thickness or layering used to calculate radial inflow and in-well flow, ft
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Ls  length of screen or open interval, ft

Mz  mixing zone of pump, ft

PAT  Purge Analyzer Tool

PL  pump location relative to top of screen or open interval, ft

QH  horizontal radial flow within the Mz; ft
3/min

Qh1-n   individual layered radial flow from discretized layers (denoted as 1-N); the 
  summation of Qh1-n constitutes the Qv term

Qp  average pumping rate, L/min in input field

Qp’  adjusted average pumping rate that accounts for wellbore storage (Qw), ft3/min

Qv  vertical flow entering the mixing zone (Mz) from the summation of layered 
  radial flow; ft3/min

Qw  flow from wellbore storage, ft3/min

Re  Reynolds number, a dimensionless number used to compare the ratio of inertia 
  force to viscous force. In hydraulics it is used to assess flow turbulence.

Ro  radius of influence, ft

s  drawdown at the well, ft

S  storage coefficient, dimensionless

T  transmissivity

tpurge  actual (reverse mode) or anticipated (forward mode) purge time, min

tmin  potential minimum purge time, computed from the in-well travel time based on 
  the V and the length of the well screen, min

V  unidirectional maximum vertical velocity (ft/min)

Volumetric 
purge time

amount of purge time required to evacuate the equivalent of three-saturated 
well volumes 





Instructions for Running the Analytical Code PAT (Purge 
Analyzer Tool) for Computation of In-Well Time of Travel of 
Groundwater under Pumping Conditions

By P.T. Harte,1 B.J. Huffman,1 Tomas Perina,2 Herb Levine,3 and Daewon Rojas-Mickelson3

Introduction
Understanding the optimal time needed to purge a well 

while pumping to collect a representative groundwater sample 
requires an understanding of groundwater flow in wells 
(in-well flow). Parameters that affect in-well flow include 
the hydraulic properties of the aquifer, well construction, 
drawdown from pumping, and pump rate. The time of travel 
relative to in-well flow is affected by the pump’s intake loca-
tion. The Purge Analyzer Tool (PAT) incorporates hydraulic 
calculations to help assess the optimal purge times required 
to vertically transport groundwater in the well to the pump 
intake (Harte, 2017). Harte (2017) includes a discussion on 
the rationale for determining in-well groundwater flow and 
time of travel and also discusses the limitations inherent in the 
PAT; an understanding of the limitations is important to ensure 
proper use.

The PAT calculates flow by use of the Dupuit-Theim 
equation (Lohman, 1979) that assumes steady-state radial flow 
and a total inflow from the well opening or screen equal to the 
pumping rate (eq. 1). A bulk average hydraulic conductivity 
(Kavg) is derived from this relationship. Once Kavg is calculated, 
the program calculates incremental (layered) horizontal radial 
inflow into the well over user defined increments (layers). 
These defined increments represent the screen or well open-
ing as a fraction of the total inflow. The amount of inflow per 
layer is proportional to the user-defined layered distribution of 
hydraulic conductivity (Klayer) because drawdown is assumed 
to be uniformly distributed in the well. The water budget equa-
tion that guides the solution of the PAT (eq. 1) is specified as:

Q Q Q Qp v H w� � � (1)

where
 QP is pumping rate,
 Qv is vertical flow entering the boundary of the 

mixing zone (Mz) from the summation of 
layered radial flow ( Qhl n�� ) where 1-n
denotes number of layers,

 QH is horizontal radial flow into the mixing zone 
(Mz), and

 Qw is flow from wellbore storage effects.
The in-well flow is computed from the convergence of 

incremental (layered) radial inflows (Qh1-n) summed to the 
total vertical flow (QV) entering the adjacent zone to the pump 
intake (called mixing zone [Mz]) as shown in figure 1. The Qv 
is transported as one-dimensional piston flow. Within the Mz, 
it’s assumed that flow to the pump is dominated by horizon-
tal radial flow (QH) when the pump is in the open interval of 
the well. Flow from the wellbore storage (Qw) is computed 
from the volume of water pumped from the well at the time 
of the drawdown (s) measurement(s). Aquifer storage effects 
are unaccounted for but are likely to be problematic when 
(1) dewatering within the well opening occurs or (2) when
the water table is close to the top of the well screen or open
interval where additional flow into the upper portion of the
well opening may occur. For fully saturated wells tens of feet
below the water table, storage effects are likely to be more
uniformly distributed across the well screen or open interval
(regardless of confined or unconfined conditions). Therefore,
radial inflow from storage will be less prominent under pump
rates commonly used in groundwater sampling either for volu-
metric sampling (<3 gallons per minute) or low-flow sampling
(<0.5 liters per minute).

A major benefit of the use of the PAT is the understand-
ing of time-varying, vertical integration of captured pump 
water. The analytical model computes aquifer (formation) 
capture intervals relative to the open interval of the well. This 
information is displayed graphically (called aquifer fraction 
graphs) and can be used to assess the likely formation intervals 
contributing water to the sample at any time.

1U.S. Geological Survey.
2APTIM, Inc.
3U.S. Environmental Protection Agency.
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Figure 1. Schematic of the allocation of flow in the well while pumping for the Purge Analyzer Tool.

Contents of Program

The PAT is contained within a macro-enabled Microsoft 
Excel file with a *.xlsm extension. Contained in the Excel file 
are multiple worksheets. There are three worksheets for the 
case of homogeneous hydraulic conductivity (Klayer is uniform) 
and an additional worksheet if a heterogeneous condition 
(Klayer is nonuniform) is simulated. The operation of the ana-
lytical model is discussed in the “Operation” section.

Requirements 

The PAT (Purge Analyzer Tool) is a Microsoft Excel 
VBA macro code for computation of in-well travel times of 
groundwater under pumping from wells. Excel versions dated 
2016, 2013, or 2010 are required. For Excel 2007, certain 

functions to display charts will not work. Many commands 
that do not work in Excel 2007 are associated with the charts 
aesthetic nature and can be commented out by adding a single 
quote (‘) to the beginning of the command line in the embed-
ded VBA macro called “HV_Pump_Flow.” Most users (per-
mission dependent) will be able to open the VBA macro by 
going to the Developer tab, selecting macro, and then selecting 
the VBA macro called “HV_Pump_Flow” under the module 
where macros are stored.

Excel files must be saved as a macro enabled .xlsm 
workbook. On certain computer systems, the user will need 
to open the file and then resave the macro-enabled Excel file 
under a new name to meet security requirements.

The Data Solver Add-ins in Excel must be enabled for 
VBA code operation. For many computer systems, the default 
configuration is likely to be disabled. There are several meth-
ods to check if Solver is enabled including on the “Data” tab 
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of an Excel workbook (if it is visible on the ribbon); under 
“Add-Ins” of the options menu under the “File” tab; and on 
the “Developer” tab under the “Excel Add-ins” menu. It may 
also be necessary to ensure that the “Developer” tab is shown 
on the command toolbar along with the “Add-ins” ribbon. 
This is done by selecting “Options” under “File” drop-down 
tab. Under options select “Customize Ribbon” and check 
“Developer” and “Add-ins” to make them viewable in the 
“Main Tabs” ribbon. In the new window, click the “Tools” tab 
and click on “References.” The box next to “Solver Add-ins” 
must be checked. Go back to the “Developer” tab and click on 
“Excel-Add-ins.” The “Data Solver Add-ins” should now be 
checked. After ensuring the “Data Solver Add-ins” is invoked, 
save the workbook using the macro-enabled .xlsm suffix.

Instructions 

This and the following sections explain the general 
operational steps of the program for reverse and forward mode 
in the instructional worksheet. Normally, the PAT is used in 
reverse mode where field data were collected and the Kavg is 
unknown but can be calculated. In this case, some vertical 
flow is assumed to occur based on the relations specified in 
equation 1 because of the division of flow between QH in the 
Mz and the flow in the rest of the screen or open interval out-
side of the Mz where (Qv) is computed and tracked. However, 
if Kavg is known from prior information then the PAT can be 
used in forward mode to assess the likelihood of Qv occurring 
in the well. In other words, for a given drawdown, the pro-
grams checks if there is sufficient QH in the Mz to satisfy the 
adjusted pump rate (Qp’); under this case Qv approaches zero. 
The macro (RUN MODEL button) is not invoked in this case 
because Kavg is already known.

Input Worksheet

Data are entered under the worksheet labeled “Input” 
of the *.xlsm Excel file. Input parameters that describe well 
purging, well construction, and water levels are specified 
in the gray shaded cells B4:B13 (fig. 2). The depth to water 
(DTW; cell B6) is the static water level in feet (ft) below land 
surface. The depth to screen or open interval (DTS; cell B7) 
is the top of the well opening in ft below land surface. The 
length of the screen (Ls) is the difference in ft between the 
top and bottom of the well opening. The diameter of the well 
(Dwell) is for the well opening. If the well casing diameter dif-
fers from the opening, then a correction factor can be applied 
to the drawdown (s) cell B12. Values in cells B10:B12 should 
represent data that were collected contemporaneously. The 
anticipated purge time (tpurge; cell B10) and drawdown (s; in 
cell B12) are used in the Qw calculation for wellbore stor-
age depletion rate. The assumption is that the drawdown has 
stabilized.

The heterogeneity factor (HF) is an important param-
eter to simulate homogeneous (HF = 1) or heterogeneous 

PAT=PURGE ANALYZER TOOL

Input Parameters Inputs

Well Name test

Date (mm/dd/yyyy) Units

Depth to Water below reference, DTW 9.00 �

Depth to Top of Screen below reference, DTS 30.00 �

Length of Screen, Ls 10.00 �

Well Diameter, Dwell 1.5 inches

Actual or An�cipated purging �me, tpurge 70.0 min

Averaged Purge Rate, Qp 0.300 L/min

Drawdown, s 10.00 �

Heterogeneity Factor, HF (1=Homogeneous) 1.00
Dimensi
onless

Ini�al Inputs & Calcula�ons

Figure 2. Reproduction of user-specified input parameters (cells 
B4:B14) on the “Input” worksheet for the Purge Analyzer Tool. 
[ft, feet; min, minutes; L/min, liters per minute]

conditions (HF greater than 1). HF (cell B13) is specified as a 
multiple between the lowest and highest hydraulic conductiv-
ity of an individual layer (Klayer) encountered along the well 
opening. For example, if a multiple of 10 is specified as a 
value of HF, the highest Klayer would be 10 times the lowest 
Klayer. The thickness in which Klayer can vary is set depending 
on the layer thickness (LT). For homogeneous conditions, the 
Klayer of individual layers will be uniform and equal to Kavg. 
For heterogeneous conditions, specifying a multiplier greater 
than 1 allows for layered variability in Klayer that is constrained 
by the multiple factor specified in cell B13. An initial estimate 
of Kavg can be entered in cell B14, however once the program 
is run in reverse mode the field will be updated to the cali-
brated value. See the “Operation” section of this report for 
additional details.

Additional input parameters to run the PAT (fig. 3; cells 
B29:B32) are the pump intake position (PL) relative to the top 
of the screen or well open interval; the length of the Mz above 
or below the pump intake (specified as ½ Mz in the PAT); a 
layering thickness (LT) to compute QH into the well; and time 
discretization (dt) for the determination of aquifer capture 
(fig. 3). 

The depth of the PL within the well screen or open inter-
val is specified by positive distances from the top of the well 
screen or open interval. For PL within the casing, negative 
distances are specified. The middle point of the pump intake 
should be used for its pump position.
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Program Variables Inputs Units
Pump Loca�on rela�ve to top of screen (Above 
screen specify nega�ve number for absolute 
distance), PL

5 �

1/2 Mixing Zone Buffer length above/below pump 
intake, 1/2 Mz

0.5 �

Cell Thickness of layers to compute horizontal radial 
flow, LT

0.5 �

Time interval (dt) for computa�on of flow and Aquifer 
Frac�on graph

0.5 min

Figure 3. Reproduction of user-specified program variables 
(cells B29:B32) on the “Input” worksheet for the Purge Analyzer 
Tool. [ft, feet; min, minutes]

The Mz is the vertical length of the saturated water 
column surrounding the pump intake. In Mz, inflow into the 
well is proportioned to the QH term (eq. 1). As the vertical flow 
crosses into the Mz boundary (or boundaries), no computation 
of vertical travel time occurs, and flow is assumed as instanta-
neously evacuated. Therefore, vertical transport is computed 
to the edge of the Mz. The computation of QH is set to zero 
when the pump intake is located in the well casing as no radial 
flow can contribute in Mz. At a minimum, the Mz corresponds 
to the length of the pump intake. For a pump intake length 
of approximately 1 ft or less, a value of 0.5 ft for the ½ Mz 
length (distance above and below the midpoint of the pump 
intake) can be specified in the PAT. For high pump rates, an 
Mz extended beyond the length of the intake is likely desirable 
because of turbulence. A ½ Mz value of 0.5 ft is recommended 
for most pump intakes that are less than 0.8-ft long. The Mz 
affects the vertical time of travel computations and the time of 
aquifer fraction captured because vertical transport is only cal-
culated up to the Mz boundary (or boundaries). This is regard-
less if the PL is in the casing or well opening (appendix 1).

LT is used to vertically discretize the saturated water 
column to compute horizontal flow and corresponding vertical 
flow over the user-defined distances. The LT should be equal 
to or less than the Mz length and the Mz should be a divisible 
by LT with no remainder, although a nondivisible LT specifica-
tion will still work. For example, if there is a Mz of 0.5, a LT of 
0.1 or 0.25 would be acceptable.

Specification of the dt allows for higher or lower resolu-
tion of the vertical time of travel computation. This allows for 
a higher resolution discretization of the aquifer fraction graph. 
The smaller the dt, the smoother the aquifer fraction graph 
will appear. Specification of a dt that is too small will result 
in a longer solution runtime. The user can initially specify 
a relatively large dt (2 minutes) and reduce in subsequent 
simulations if the aquifer fraction graph appears irregular 
or nonsmooth.

There are other cells in the “Input” worksheet that are not 
related to input parameters but are cells reserved for calcula-
tion and description of parameters. The cells B15:C16 (fig. 4) 
are reserved for forward mode only when manual specifica-
tion of Kavg is input into cell B14 and the reverse mode is not 
invoked (“RUN MODEL” Button on “Input” worksheet is not 
used). In forward mode, whether Qv occurs in the well for any 
given Qp’ is dependent on whether QH for the assigned Mz is 
sufficient to satisfy the Qp’ pump rate. Forward mode is further 
discussed in the “Operation” section.

Cells in B18:B26 are calculated by the program and listed 
under the column heading “Outputs” (fig. 4). The minimum 
potential equilibrium pump rate, in cell B18, is the summed 
flow from QH and Qv in cubic feet per minute. The minimized 
residual as determined by Excel’s solver when running the 
PAT in reverse mode can be seen in cell B19. This minimized 
residual is the difference between the minimum potential equi-
librium pump rate (cell B18) and the Qp’ (Qp minus Qw). The 
minimized residual should be close to zero. Additional discus-
sion on Excel solver use is included in the “Solver” section of 
the report. The observed Qw (cell B20) represents the vol-
ume of water in the well removed by the drawdown (s). The 
maximum vertical wellbore velocity (V; cell B21) assumes 
unidirectional flow and is computed from Qp’ divided by the 
wellbore cross-sectional area. An external check on flow can 
be done using the value from cell B21 in the Reynolds equa-
tion (Streeter and Wylie, 1985) to check against the potential 
for turbulent flow, by calculating the Reynolds number (Re), 
where the laminar flow regime holds for cases of Re < 2,000. 
The adjusted maximum vertical wellbore velocity, in cell B22, 

Figure 4. Reproduction of output fields (cells B15:B26) from the 
“Input” worksheet for the Purge Analyzer Tool. [ft3/min, cubic feet 
per minute; ft, feet; min, minute; ft2/day, square feet per day]
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includes the Qw that occurs during tpurge. The potential mini-
mum purge time (tmin; cell B23) is computed from the in-well 
travel time based on V and the Ls The purge time required to 
remove three well casing volumes of water (volumetric purge 
time) is provided in cell B24 for comparison. The transmis-
sivity (T) for the well opening (cell B25) is Kavg * Ls. Both Kavg 
and T are representative of the well opening length (Ls) and 
not the aquifer thickness.

Output Worksheet

The “Output” worksheet lists the results of the PAT in 
reverse mode (fig. 5). Columns A through J list tabular data 
related to radial flow, vertical velocity, and travel time to 
the PL bounded by the Mz. Column A lists the index number 
for each discretized layer whereas columns B and C list the 
centroid position and radial inflow corresponding to the index 
number. Column D lists the index number for each verti-
cal face between the discretized layers. Column E lists the 
vertical face position, and column F lists the vertical velocity 
calculated corresponding to the index number in column D. 
Column G lists the linear travel time, and column H lists the 
travel time accounting for acceleration. Column I lists the time 
since the start of pumping, and column J lists the fraction of 
inflow from recharge (aquifer) captured by the pump divided 
by the total inflow into the well from the formation.

There are four graphs displayed on the “Output” 
worksheet. They include the horizontal radial flow graph 

(fig. 6), the vertical velocity graph (fig. 7), the in-well travel 
time to the Mz (fig. 8), and the aquifer fraction graph (fig. 9). 
For graphs in figures 6–8, the ordinate tick marks and labels 
correlate to the LT specified on the “Input” worksheet; in this 
case, an LT of 0.25 ft was specified. All output figures dis-
played in this report are for conditions specified in the input 
fields shown in figures 2 and 3.

In the example provided (fig. 6), the well inflow is uni-
form for a homogeneous condition. The pump intake is set at 
the middle of the well screen as delineated by Mz (fig. 6; green 
lines). No inflow occurs in the well casing as noted by zero 
inflow (fig. 6; red dotted line) above the top of the opening 
(fig. 6; black dashed line). Figures 7 and 8 also show the loca-
tion of Mz and the top of the well opening. 

Figures 7 and 9 show the vertical velocity and in-well 
travel times, respectively, under a homogeneous case. For a 
homogeneous condition where the pump is set at the middle 
of the well opening, radial flow, vertical velocity, and in-well 
travel time are symmetric. Both the linear velocity and accel-
eration velocity schemes are provided in figure 8; the accelera-
tion velocity is used in the calculation of capture.

Figure 9 compares the fraction of inflow from the aquifer 
during pumping (red line) to the actual (reverse mode) or 
anticipated (forward mode) purge time (gray line) and the 
purging time required to remove three-casing volumes of 
water from the well (orange line). The purge time associ-
ated with the aquifer fraction needed to collect a repre-
sentative sample is defined by the travel time to vertically 

Figure 5. Reproduction of tabular data 
outputted on the “Output” worksheet for the 
Purge Analyzer Tool. [ft, foot; ft3/min, cubic 
foot per minute; ft2/min, square foot per 
minute]
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Figure 6. Reproduction of the horizontal radial inflow graph 
provided on the “Output” worksheet of the Purge Analyzer Tool. 
Example from a homogeneous condition. Simulated horizontal 
flow is uniform as denoted by the red dots and line. [cubic feet/
min, cubic feet per minute]

Figure 7. Reproduction of the vertical velocity graph from the 
“Output” worksheet for the Purge Analyzer Tool. Example from 
a homogeneous condition where uniform well inflow occurs. 
Vertical flow (red line) to the mixing zone (parameter Mz; green 
line) is symmetric if the pump intake (parameter PL) is set at the 
middle of the well opening. [feet/min, feet per minute]
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Figure 8. Reproduction of the in-well travel time graph from the 
“Output” worksheet for the Purge Analyzer Tool. Example from a 
homogeneous condition and pump intake at the middle of the well 
opening showing linear velocity and corrected for acceleration. 
For in-well travel time, the regular linear velocity (solid red square) 
and velocity corrected for acceleration (open red triangle) are 
shown for reference. Travel times computed when accounting for 
acceleration are significantly faster further from the mixing zone 
(Mz, green line). [min, minute]
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Figure 9. Reproduction of the aquifer fraction graph from the “Output” worksheet for the Purge Analyzer Tool. 
Example from a homogeneous condition and pump intake at the middle of the well opening. The red line is travel 
time to pump capture as calculated from the Purge Analyzer Tool, the gray line is the specified purge time, and the 
solid vertical orange line is the volumetric sample time from the extraction of the equivalent pumped volume of 
three well casings. [min, minutes]

transport inflow along the entire well opening; in this case at 
60 mins (fig. 9). In contrast, the purge time needed to extract 
three-casing volumes of water is 107 mins (fig. 9). For sample 
collection purposes, if field parameters stabilize after 60 mins, 
the PAT indicates a representative sample can be collected 
anytime afterwards.

Operation
The PAT can be run in reverse (calculation of Kavg) or 

forward mode (user-specified Kavg). For the reverse mode, 
the Excel solver is automated and executed from within the 
program. Additional information on the subject is discussed in 
the “Solver” section of the report.

Reverse Mode

Reverse-mode execution is invoked by clicking on the 
“RUN MODEL” button on the “Input” worksheet. If an HF of 
1 is specified, then the program will terminate on the “Output” 
worksheet, otherwise an intermediate step is involved. In this 

step, the PAT active worksheet is moved to the “K-Distribu-
tion” worksheet where the distribution of Klayer will be defined.

Option 1: Homogeneous (HF = 1)

The PAT brings the user directly to the “Output” work-
sheet when HF = 1. Each layer’s Klayer is set equal to Kavg. 
Regardless of whether homogeneous conditions are simulated, 
the PAT will display homogeneous conditions (red line) as a 
reference on the graphs plotted in the “Output” worksheet.

Option 2: Heterogeneous Conditions (HF > 1)

When HF > 1, the PAT takes the user to a worksheet 
called “K-Distribution.” This intermediate step requires the 
user to specify a distributional pattern for each Klayer assigned 
to each discretized cell. The range allowed for any Klayer is 
calculated based on the HF entered at the “Input” worksheet, 
and the calculated Kavg for the screen or open interval is also 
on the “Input” worksheet. The calculations for the allowable 
values, highest hydraulic conductivity (Khigh), middle hydraulic 
conductivity (Kmedium), and low hydraulic conductivity (Klow) 
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are shown in equations 3 and 4. The Kmedium is allowed to 
vary by ±50 percent of the calculated Kavg. An example of the 
“K-Distribution” worksheet is shown in figures 10 and 11.

 K
K K

medium
high low�

�

2
, (3)

 K HF Khigh low= *  (4)

Once at the “K-Distribution” worksheet, the user can 
select a distribution of Klayer from the drop-down menu in 
cells D2:E2 (fig. 10). Values of Klayer are specified in absolute 
hydraulic conductivity units. There are eight different Klayer 
patterns to select from (oscillating formation, rock fracture at 
top of well opening, rock fracture at middle of well opening, 
rock fracture at bottom of well opening, double rock fracture, 
bimodal formation, trimodal formation, and randomized for-
mation). With a pattern selected, the user must hit the “Popu-
late” button (cells D1:E1, to have Klayer pattern automatically 
designated within the worksheet. It also is possible to specify a 
user-defined pattern where each layer can be manually entered 
a value of “L” (Klow), “M” (Kmedium) or “H” (Khigh) in column 
A under the heading “K Type.” In this case, the “Populate” 
button is not invoked. Before continuing with the program, 
the “Residual” button (“Resolve Error” button) and then the 
“Done with the Script” button (cells H1:J1) must be invoked. 
After hitting the “Done with the Script” button, the program 
continues and ends on the “Output” worksheet.

An example of a populated Klayer distribution is shown 
in figure 11. After the Klayer values have been populated or 
manually entered, the user must click the “Resolve Error” 
button (cells D3:E3) to minimize the difference between the 
bulk average of the Klayer distribution and Kavg computed on 
the “Input” worksheet. Some variation (up to 10 percent) is 
allowed between the summation average of the specified Klayer 
and the Kavg. This is done to facilitate solution under heteroge-
neous conditions and from a practical standpoint to acknowl-
edge an appropriate level of precision in the computed Klayer. 
To continue the PAT, the user then hits the “Done! Continue 
Script” button (cells H4:J5) to complete the task and move to 
the “Output” worksheet.

Forward Mode

For forward-mode processing, the user specifies the 
known Kavg in cell B14 of the “Input” worksheet. The QH from 
the Dupuit-Theim equation is calculated within the associated 
Mz using Kavg and compared against the Qp’ to assess if Qv 
outside Mz can take place. A “NO” is shown in cells B15:C16 
of the “Input” worksheet when it is unlikely that Qv in the 
well is dominant, as discussed in Harte (2017). Note that if the 
PL is in the casing, Qv is assured. When the solver is invoked 
(reverse mode), the solver minimizes differences between the 
Qp’ and the combined flow from QH and Qv. Therefore, for the 

reverse mode, the default assumption is some Qv contributes to 
satisfying Qp’.

Solver

The Excel data solver is embedded into the PAT macro 
and is invoked in reverse mode to reduce the residual (speci-
fied in cell B19 in the “Input” worksheet) between Qp’ and 
the summation of QH and Qv by altering Kavg. The lowest Kavg 
value allowed is 0.01 ft per day. Values <0.01 ft per day are 
primarily affected by aquifer storage during sampling and the 
PAT does not calculate aquifer storage.

The generalized reduced gradient nonlinear solver option 
with forward derivatives is used with a convergence criterion 
of 0.0001. This method looks at the gradient or slope of the 
objective function as the input values or decision variables 
change and determines if an optimum solution is reached 
when the partial derivatives equal zero. Of the two nonlinear 
solving methods, generalized reduced gradient nonlinear is 
the fastest. However, the solution derived from this algorithm 
is highly dependent on the initial conditions and may not be 
the global optimum solution. The solver may stop at the local 
optimum value nearest to the initial conditions, giving the 
user a solution that may or may not be optimized globally 
(Engineeringexcel.com, 2018). The user may want to perform 
repeated simulations of the same purge to evaluate if the same 
Kavg is being obtained for each solution. Calculation of the 
same K  would suggest a global solution is being obtained by 
the solver and not a localized solution.

Under certain cases, a solution may not be reached for 
cases of excessive drawdown (dewatering of the well screen), 
dewatering of the Mz, or in the solution of low hydraulic con-
ductivity values of “tight” formations. Reducing the length of 
Mz may assist in achieving a solution in some cases.

avg

Assumptions and Limitations

There are multiple assumptions and limitations associated 
with the use of the PAT. The most important limitation is that 
the PAT assumes steady-state conditions although depletion of 
well storage is accounted for by adjusting pump rates by the 
well volume depleted. Users who need simulations of more 
complex wellbore flow processes should consider the use of 
numerical models for wellbore flow such as the Multi-Node 
Well package of MODFLOW (Halford and Hanson, 2002).

Important assumptions of the model include:

1. Confined, steady-state conditions approximate radial 
flow (Dupuit-Theim equation).

2. The formation adjacent to the well opening is the con-
trolling part of the aquifer contributing water to the well.
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Figure 10. Reproduction of the “K-distribution” worksheet before layer entry for the Purge Analyzer Tool. [HF, 
heterogeneity factor; ft, feet; ft/day, feet per day]
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Figure 11. Reproduction of the “K-distribution” worksheet after layer entry using a rock fracture analogy where the 
fracture exists at the middle of the well opening for the Purge Analyzer Tool. Values are absolute and specified based 
on relation in equation 3 [HF, heterogeneity factor; ft, feet; ft/day, feet per day]
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3. Vertical velocity in the well-screened interval is an 
average velocity calculated by assuming piston flow (no 
frictional effects).

4. Horizontal flow into the well from the formation is 
assumed. Users should know that this may not be the 
case for many shallow monitoring wells or partially 
penetrating wells that are affected by converging 
vertical flow.

5. Flow in the well is vertical toward the pump intake 
outside Mz.

6. Drawdown (s) in the well is uniform over the well 
opening.

7. Qv is calculated by a conservation of mass at each dis-
cretized interval.

8. The radius of influence (Ro) is set at 10 feet.

9. Storage (S) contributions from outside the well is 
assumed negligible.

10. The effects of the sand pack on the horizontal or vertical 
flow is not accounted for.

11. The well screen or well opening is assumed to be 
unclogged and not a limiting factor in well inflow.

12. Travel time from the Mz to the pump intake and to the 
surface via the discharge line is not accounted for but is 
assumed to be small.

13. In-well flow outside the Mz is laminar.

14. No ambient flow is present.

15. For the reverse mode, Qv contributes to satisfying pump 
rate Qp’.

Transient storage effects may be significant in cases 
where the drawdown (s) takes significant time to stabilize, in 
which case the analysis will overestimate values of Kavg. The 
impact of formation S on Kavg was evaluated by comparing the 
calculated Kavg from the Theis equation, which accounts for 
aquifer storage, to the calculated Kavg from the Dupuit-Theim 
equation as used by this analytical model (Harte, 2017). For 
a 1-ft drawdown or less, the effect of S for values of < 0.001 
results in a small error (approximately a factor-of-2 difference) 
in the Kavg calculated with this model. As long as the distri-
bution of well inflow remains relatively the same along the 
screen and S is uniform, effects on the computation of travel 
time by the PAT should be relatively small.

Another important limitation is the effect of the Mz and 
pump tubing in extending travel time to the surface where 
samples are retrieved, as the PAT does not account for these. 
Travel times could be a factor for Mz > 3 ft and discharge lines 
> 100 ft. In most cases, an Mz of 1 ft will produce a delay of 
only a couple of minutes. However, a discharge line of 100 ft 
could delay travel times to the surface by more than 3 mins. 

Therefore, as a rule of thumb, samples should be collected 
after 10 mins of reaching capture criteria indicated by the PAT.

A sand pack is not simulated in the model. For an open 
borehole, a sand pack is not applicable because it is not used. 
However, a sand pack for a well screen can affect the distribu-
tion of well inflow particularly if it extends beyond the well 
screen interval. In this case, it will increase radial flow in the 
adjacent upper or lower interval of the well screen.

Lastly, well clogging can prevent well inflow from layers 
that may or may not be productive. Where a sand pack is used, 
the sand pack will redistribute well inflow to other intervals 
of the well screen that are not clogged. Therefore, the interval 
receiving redistributed radial well inflow will have water from 
another layer and not be indicative of water chemistry from 
that layer. Simulations with PAT will not be able to replicate 
the redistributed well inflow.

Applications
With little information besides well construction, 

anticipated PL, and pumping rates, the effect of various levels 
of heterogeneity can be assessed on in-well flow and time 
of travel during sampling. Table 1.1 and figure 1.1 illustrate 
differences between homogeneous and heterogeneous condi-
tions for a hypothesized case of a single fracture in a rock well 
where the fracture is positioned at different locations (intersec-
tions) in the well opening. For the simulations shown, the PL 
is located at 2 ft below the top of the casing and within a 10-ft 
well opening using the input parameters from figure 2 of this 
report. The homogeneous case shows a smoother transition 
of aquifer capture. For the heterogeneous cases that simulate 
a single fracture 100 times the hydraulic conductivity of the 
rock matrix (nonfractured part of rock), the distance between 
the PL and fracture location dominates in-well flow and travel 
times. A one-order-of-magnitude difference (10 to 100 mins) 
in arrival time of flow from the fracture, as indicated by the 
first steep rise on the aquifer fracture graph, occurs when the 
fracture is located at opposing ends of the well opening (top or 
bottom of well opening). The tails are a product of the small 
inflow from the rock matrix, and the spikes represent the large 
inflow from the fracture. Placing the PL in the well casing will 
exacerbate this difference and increase differences in capture 
times.

Based on fracture location, an elongated tail may occur 
between 90 to 100 percent capture or 0 to 10 percent capture 
depending on the PL (appendix 1). When the fracture is located 
at the bottom of the well opening (appendix 1), the initial 
percent capture of water is small, increasing slowly until the 
water contributed by the fracture reaches the pump intake 
(approximately at 90 min) ramping the percent capture to 
90 to 100 percent almost immediately; under this case there is 
no elongated tail at the end. This sequence of percent capture 
is flipped when the fracture is located at the top of the well 
opening (appendix 1). Following the start of capture of water 
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from the fracture (appendix 1; >10-min mark), an elongated 
tail ensues between 90–100 percent capture time from the 
contribution of flow from the rock matrix. For all practical 
purposes, stabilization of physicochemical characteristics of 
water quality would likely occur at the 90 percent capture 
mark. Other application examples are provided in appen-
dixes 2 and 3. In appendix 2, an example showing the applica-
tion of assigning heterogeneity in the simulation based on a 
lithologic log is included. In appendix 3, an example showing 
the effect of well construction on travel times and aquifer 
capture is provided.

Summary
The Purge Analyzer Tool (PAT) can be used to help guide 

sample considerations (pump location, rate, and time) needed 
to help collect representative groundwater samples from 
wells. The criteria used to assess sample representativeness 
is the time needed to complete flushing of the well opening 
by allowing sufficient piston transport time for groundwater 
originating from the well opening to reach the pump intake. 
Prior to that time, pumped water is a combination of well 
water in storage and recent inflow from the aquifer. In reality, 
sample representativeness is a subjective term dependent on 
study objectives. Therefore, the greatest utility of PAT may 
be the insight gained into the nature of time-varying capture 
of purged water and how that may relate to targeted sample 
volumes. The PAT can be used also to assess the sensitivity of 
aquifer capture of groundwater sampling networks to factors 
such as heterogeneity; providing a new variable in the assess-
ment of water chemistry results. Users should be fully aware 
of the limitations and assumptions incorporated into the PAT 
including the assumption of steady-state flow although well 
storage depletion is accounted for by adjusting the pump rate. 

Historically, confirmation of sample representativeness 
for low-flow sampling and volumetric extracted sampling 
(Barcelona and others, 1994) has depended on stabilization of 
drawdown and stabilization of physicochemical water qual-
ity characteristics such as specific conductance and water 
temperature. The PAT offers another method to assess capture 
by coupling arrival time of sample water to the pump intake to 
the stabilization of physicochemical water quality characteris-
tics. In cases where contemporaneous stabilization and arrival 
times (as demonstrated in capture graphs) are noted, physico-
chemical stabilization can be confirmed, thereby avoiding pre-
mature sampling based on temporary periods of stabilization. 
In cases where they are not contemporaneous, the differences 
in time can be assessed to help evaluate whether further purg-
ing may be required given sampling objectives.
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Appendix 1. Solution Examples using Purge Analyzer Tool

The effect of PL and Mz on simulated travel times is pre-
sented in this section. Both parameters affect hydraulic con-
trols on flow and time of travel. Also, in this section, the effect 
of formation heterogeneity on travel times is illustrated for a 
simple case of a single fracture in competent rock intersecting 
the well at different depths.

Effect of the mixing zone (Mz)

Table 1.1 summarizes the range of travel times for well 
and hydraulic conditions noted in figure 1 while adjusting val-
ues for two parameters: (1) the placement of the pump intake 
(PL) and (2) size of the mixing zone (MZ). Capture times are 
sensitive to both parameters as denoted by the time to achieve 
100 percent capture. For example, a pump intake set in the 
casing (PL < 0) will increase travel times by over 8 minutes. 
Additionally, a larger Mz will decrease computed travel times 
by 1.5 minutes because vertical travel is determined up to the 
boundary of Mz.

Effect of Heterogeneity

This section includes an example of the effect of fracture 
position relative to PL on travel times and the amount of aqui-
fer fraction captured during pumping. While steady-state flow 
is assumed for these simulations, transport is transient, and the 
amount of aquifer capture varies until equilibrium is reached 
as measured by the arrival time of the most distant intervals 
of formation water. The shape of the aquifer capture curves 
provides insight into the proximity of the fracture relative to 
the PL (fig. 1.1).

Table 1.1. Effect of pump location (PL), mixing zone (Mz), and horizontal flow (QH) on travel times. [ft3/min, cubic feet per 
minute; ft, feet]

Simulation 
number

Qp
8 

(ft3/min)
Qp’

9 
(ft3/min)

s1 
(ft)

Ls
4
 

(ft)
Lcw

2
  

(ft)
PL

6 
(ft)

QH
7
  

(ft3/min)
1/2Mz

5 
(ft)

LT
3 

(ft)

100-percent 
capture time 

(minutes)

1 0.0106 0.0085 10 10 11 −3 0 1.5 0.25 83.5
2 0.0106 0.0085 10 10 11 −3 0 0.5 0.25 85
3 0.0106 0.0085 10 10 11 −1 0 0.5 0.25 82
4 0.0106 0.0085 10 10 11 2 0.0008 0.5 0.25 76.5
5 0.0106 0.0085 10 10 11 5 0.0008 0.5 0.25 69
6 0.0106 0.0085 10 10 11 5 0.0017 1.5 0.25 60.5
7 0.0106 0.0085 10 10 11 8 0.0008 0.5 0.25 76.5

1s Drawdown
2Lcw Length (height) of casing water under pumping conditions above top of well opening, ft
3LT Cell thickness or layering used to calculate radial inflow and in-well flow, ft
4Ls Length of screen or open interval, ft
5Mz Mixing zone of pump, ft
6PL Pump location relative to top of screen or open interval, ft
7QH Horizontal radial flow within the Mz, ft

3/min
8Qp Average pumping rate, L/min
9Qp’ Adjusted average pumping rate that accounts for well storage (QW), ft3/min
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Figure 1.1. Graphs showing effect of heterogeneity on amount of 
pumped water captured from the aquifer (aquifer fraction capture) 
for A, fracture at top of well opening, B, fracture at middle of well 
opening, and C, fracture at bottom of well opening. [min, minutes; 
Pump position is at 2 feet below the top of the well opening]
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Appendix 2. Incorporation of Stratigraphic Information in Simulation 

While appendix 1 included simulation examples of hypo-
thetical conditions, appendix 2 (and 3) include examples of 
actual field data from sites. Appendix 2 includes an example of 
a lithologic log from a monitoring well at the Longhorn Army 
Ammunition Plant in Karnack, Texas (AECOM Technical 
Services, Inc., 2015), and the simulated output from a bimodal 
hydraulic conductivity distribution that was informed by the 
log (figs. 2.1 and 2.2). The upper part of the well screen was 
simulated with a relatively low hydraulic conductivity and the 
underlying unit was simulated with a high hydraulic conduc-
tivity to match the stratigraphic pattern from the log.
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Figure 2.1. Lithologic log from monitoring well 18CPTMW18, a 1.5-inch diameter well with a 10-(foot; ft] screen, located at an 
ammunition site in Texas that shows a predominantly clayey unit from 24.2 to 30.5 ft depth below land surface and a slightly 
coarser underlying silty sand from 30.5 to 34.2 ft below land surface. [ft, feet; CL, clay; SP, fine sand; SM, silty sand with clay; TD, 
total depth]
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EXPLANATION
HeterogenousHomogeneous

Figure 2.2. Aquifer fraction captured while pumping for monitoring 
well 18CPTMW18 with a simulated bimodal hydraulic conductivity 
distribution at a factor of 5 between low (top of screen) and high 
(bottom of screen) KLayer where pump position was placed at A, 1 
foot below top of opening, B, 5 feet below top of opening, and C, 
9-ft below top of opening. [KLayer, hydraulic conductivity of modeled 
layers; min, minutes]
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Appendix 3. Additional Examples of Input and Output

Appendix 3 includes input and output example of a 
homogeneous condition for two monitoring wells located 
in New Mexico near the Homestake Superfund site (Harte 
and others, 2019). Whereas the formation at both wells have 
similar Kavg, the differences in well diameter and length of 
screen affects capture times (figs. 3.1 and 3.2). The time to 
achieve 90 percent aquifer capture is much quicker for well 
ND (fig. 3.1) than for well DD2 (fig. 3.2) because of the longer 
screen interval for well DD2.
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Figure 3.1. Reproduction of A, input parameters, B, model simulation parameters, and C, aquifer fraction captured while pumping for 
monitoring well ND in New Mexico under homogeneous conditions. [90 percent capture is at 21 minutes; ft, feet; min, minutes; L/min, 
liters per minute]
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Figure 3.2. Reproduction of A, input parameters, B, model simulation parameters, and C, aquifer fraction captured while pumping for 
monitoring well DD2 in New Mexico under homogeneous conditions. [90 percent capture is at 63 minutes; feet; min, minutes; L/min, 
liters per minute]
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